
 

 

 

 

 

 

MedCalc
á

 

for Windows 

 

 

statistics for 

biomedical research 

 

software manual 
 

 

 

 

 

 

 

 

MedCalc Software 

Broekstraat 52 

B-9030 Mariakerke 

Belgium 

 

http://www.medcalcsoftware.com/ 

 

http://www.medcalcsoftware.com/


 

 

 

 

No part of this package, neither the documentation nor the software may be stored in a retrieval system, 
transmitted, or reproduced in any way, including but not limited to photocopy, photograph, magnetic, 
electronic or other method, without the prior agreement and written permission of the publisher. 

The author and the publisher make no representations or warrants with respect to the software and the 
documentation and specifically disclaim any implied warranties of fitness for any particular purpose. 

 

Microsoft, Windows, MS-DOS, PowerPoint, Excel, Paintbrush, Windows Vista and the Windows Vista Start 
button are trademarks or registered trademarks of Microsoft Corporation in the United States and/or other 
countries. Other product and company names mentioned herein may be trademarks of their respective 
owners. 

 

MedCalc is a registered trademark. 
 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 
Version 12 

 

 

MedCalc
á

 

Copyright â 1993-2011 MedCalc Software bvba 

MedCalc Software 

Broekstraat 52 
B-9030 Mariakerke 
Belgium 
 
mailto:info@medcalcsoftware.com 

http://www.medcalcsoftware.com/ 

 
 

mailto:info@medcalcsoftware.com
http://www.medcalcsoftware.com/


 

www.medcalc.org  MedCalc manual - i 

CONTENTS 

CONTENTS ................................................................................................................................... I 

INTRODUCTION .......................................................................................................................... 1 
Program installation ................................................................................................................ 1 
Auto-update ............................................................................................................................ 2 
Whatôs new ............................................................................................................................. 3 
Regional settings support ....................................................................................................... 3 
The MedCalc menu bar .......................................................................................................... 3 
The spreadsheet data window ................................................................................................ 4 
How to enter data ................................................................................................................... 5 
How to enter dates .................................................................................................................. 7 
Missing values ........................................................................................................................ 9 
Data checking ......................................................................................................................... 9 
How to save data .................................................................................................................. 10 
Statistics ............................................................................................................................... 10 
Graphs .................................................................................................................................. 12 
Graph formatting ................................................................................................................... 14 
Format graph components .................................................................................................... 17 
Add graphical objects............................................................................................................ 17 
Reference lines ..................................................................................................................... 19 
Export metafile ...................................................................................................................... 21 
F7 - Repeat key .................................................................................................................... 22 
Notes editor .......................................................................................................................... 22 

FILE MENU ................................................................................................................................ 24 
New....................................................................................................................................... 24 
Open ..................................................................................................................................... 24 
Save...................................................................................................................................... 27 
Save as ................................................................................................................................. 28 
Add file .................................................................................................................................. 28 
Export ................................................................................................................................... 28 
Page setup ............................................................................................................................ 30 
Print ...................................................................................................................................... 30 
Properties ............................................................................................................................. 32 
Exit ........................................................................................................................................ 32 

EDIT MENU ................................................................................................................................ 34 
Undo ..................................................................................................................................... 34 
Cut ........................................................................................................................................ 34 
Copy ..................................................................................................................................... 34 
Paste..................................................................................................................................... 35 
Delete ................................................................................................................................... 35 
Select all ............................................................................................................................... 35 
Find ....................................................................................................................................... 35 
Find & replace ....................................................................................................................... 36 
Go to cell ............................................................................................................................... 36 
Fill ......................................................................................................................................... 37 
Insert - Remove .................................................................................................................... 38 
Transpose ............................................................................................................................. 38 

VIEW MENU ............................................................................................................................... 39 
Spreadsheet ......................................................................................................................... 39 
Show formulas ...................................................................................................................... 39 
Show gridlines ...................................................................................................................... 40 
Contents bar ......................................................................................................................... 40 
Toolbars ................................................................................................................................ 40 
Status bar ............................................................................................................................. 41 
Full screen ............................................................................................................................ 41 



 

www.medcalc.org  MedCalc manual - ii 

FORMAT MENU......................................................................................................................... 42 
Character .............................................................................................................................. 42 
Increase font size .................................................................................................................. 42 
Decrease font size ................................................................................................................ 42 
Format spreadsheet .............................................................................................................. 42 
Format graph ........................................................................................................................ 43 
Reset graph titles and options .............................................................................................. 44 

TOOLS MENU ........................................................................................................................... 45 
Sort ....................................................................................................................................... 45 
Exclude - Include .................................................................................................................. 45 
Fill column ............................................................................................................................. 46 
Stack columns ...................................................................................................................... 46 
Generate random sample ..................................................................................................... 49 
Create groups from quantiles ................................................................................................ 50 
Create random groups .......................................................................................................... 51 
Create user-defined groups .................................................................................................. 52 
Rank cases ........................................................................................................................... 52 
Percentile ranks .................................................................................................................... 53 
z-scores ................................................................................................................................ 53 
Power transformation ............................................................................................................ 54 
Edit variables list ................................................................................................................... 55 
Edit selection criteria list ....................................................................................................... 57 
Select variable for case identification .................................................................................... 59 
Enter key moves cell pointeré ............................................................................................. 60 
Options ................................................................................................................................. 60 

STATISTICS MENU ................................................................................................................... 62 
Summary statistics ................................................................................................................ 62 
Outlier detection .................................................................................................................... 66 
Histogram ............................................................................................................................. 69 
Cumulative frequency distribution ......................................................................................... 71 
Normal plot ........................................................................................................................... 72 
Dot plot ................................................................................................................................. 73 
Box-and-whisker plot ............................................................................................................ 74 
Correlation ............................................................................................................................ 76 
Rank correlation .................................................................................................................... 77 
Scatter diagram .................................................................................................................... 77 
Regression ............................................................................................................................ 79 
Scatter diagram & Regression line ....................................................................................... 81 
Multiple regression ................................................................................................................ 84 
Logistic regression ................................................................................................................ 86 
One sample t-test ................................................................................................................. 91 
Independent samples t-test ................................................................................................... 92 
Paired samples t-test ............................................................................................................ 94 
Signed rank sum test ............................................................................................................ 96 
Mann-Whitney test (independent samples) ........................................................................... 97 
Wilcoxon test (paired samples) ............................................................................................. 98 
Variance ratio test (F-test) .................................................................................................... 99 
One-way analysis of variance ............................................................................................. 100 
Two-way analysis of variance ............................................................................................. 102 
Analysis of covariance ........................................................................................................ 104 
Repeated measures analysis of variance ........................................................................... 106 
Kruskal-Wallis test .............................................................................................................. 111 
Friedman test ...................................................................................................................... 113 
Frequency table & Chi-square test ..................................................................................... 114 
Fisherôs exact test ............................................................................................................... 116 
McNemar test ..................................................................................................................... 117 
Cochran's Q test ................................................................................................................. 119 
Frequencies bar chart ......................................................................................................... 121 
Kaplan-Meier survival curve ................................................................................................ 121 
Cox proportional-hazards regression .................................................................................. 125 
Meta-analysis: odds ratio .................................................................................................... 128 
Meta-analysis: continuous measure ................................................................................... 131 
Serial measurements .......................................................................................................... 133 
Reference interval ............................................................................................................... 137 



 

www.medcalc.org  MedCalc manual - iii 

Bland-Altman plot ............................................................................................................... 141 
Bland-Altman plot with multiple measurements per subject ................................................ 144 
Mountain plot ...................................................................................................................... 146 
Deming regression .............................................................................................................. 148 
Passing & Bablok regression .............................................................................................. 150 
Coefficient of variation from duplicate measurements ........................................................ 152 
Intraclass correlation coefficient .......................................................................................... 153 
Concordance correlation coefficient .................................................................................... 155 
Inter-rater agreement (kappa) ............................................................................................. 156 
Cronbachôs alpha ................................................................................................................ 158 
Responsiveness ................................................................................................................. 161 
Receiver Operating Characteristic (ROC) curve analysis ................................................... 162 
Interactive dot diagram ....................................................................................................... 167 
Plot versus criterion values ................................................................................................. 168 
Predictive values ................................................................................................................. 169 
Interval likelihood ratios ...................................................................................................... 170 
Comparison of ROC curves ................................................................................................ 172 
Create summary statistics table .......................................................................................... 175 
Create correlation table....................................................................................................... 176 

GRAPHS MENU ...................................................................................................................... 178 
Data comparison graphs ..................................................................................................... 178 
Multiple comparison graphs ................................................................................................ 179 
Clustered multiple comparison graphs ................................................................................ 180 
Multiple variables graphs .................................................................................................... 182 
Clustered multiple variables graph ...................................................................................... 183 
Multiple line graph ............................................................................................................... 185 
Control chart ....................................................................................................................... 186 
Youden plot ......................................................................................................................... 188 

TESTS MENU .......................................................................................................................... 192 
Test for one mean ............................................................................................................... 192 
Test for one proportion........................................................................................................ 192 
Chi-square test ................................................................................................................... 193 
Fisherôs exact test for a 2x2 table ....................................................................................... 194 
McNemar test ..................................................................................................................... 195 
Comparison of means (t-test) ............................................................................................. 196 
Comparison of standard deviations (F-test) ........................................................................ 197 
Comparison of correlation coefficients ................................................................................ 197 
Comparison of two proportions ........................................................................................... 198 
Comparison of areas under independent ROC curves ....................................................... 198 
Confidence interval for a rate .............................................................................................. 199 
Comparison of two rates ..................................................................................................... 200 
Relative risk ï Number needed to treat............................................................................... 201 
Odds ratio ........................................................................................................................... 202 
Inter-rater agreement .......................................................................................................... 203 
Diagnostic test .................................................................................................................... 204 
Likelihood ratios (2xk table) ................................................................................................ 205 

SAMPLING .............................................................................................................................. 207 
Introduction ......................................................................................................................... 207 
Single mean ........................................................................................................................ 208 
Single proportion ................................................................................................................. 209 
Comparison of two means .................................................................................................. 210 
Comparison of two proportions ........................................................................................... 211 
Correlation coefficient ......................................................................................................... 211 
Area under ROC curve ....................................................................................................... 212 
Comparison of 2 ROC curves ............................................................................................. 213 

WINDOW MENU ...................................................................................................................... 215 
Cascade .............................................................................................................................. 215 
Tile ...................................................................................................................................... 215 
Arrange icons ...................................................................................................................... 215 
Split window ï Remove split ............................................................................................... 215 
Close all .............................................................................................................................. 216 



 

www.medcalc.org  MedCalc manual - iv 

HELP MENU ............................................................................................................................ 217 
Contents and Index ............................................................................................................. 217 
How to use Help ................................................................................................................. 217 
Whatôs new ......................................................................................................................... 217 
MedCalc on the Web .......................................................................................................... 217 
Register .............................................................................................................................. 217 
About MedCalc ................................................................................................................... 218 

MEDCALC SPREADSHEET .................................................................................................... 219 
Introduction ......................................................................................................................... 219 
Operators ............................................................................................................................ 219 
Relative and absolute cell addresses ................................................................................. 220 
Mathematical functions ....................................................................................................... 220 
Statistical functions ............................................................................................................. 221 
String functions ................................................................................................................... 223 
Date functions ..................................................................................................................... 225 
Logical functions ................................................................................................................. 226 
Miscellaneous functions ...................................................................................................... 227 

APPENDIX A. CONTROL KEYS ............................................................................................. 228 

APPENDIX B. FUNCTIONS OVERVIEW ................................................................................ 229 

APPENDIX C. NOTATION AND SYMBOLS ........................................................................... 231 

APPENDIX D. STATISTICAL TABLES ................................................................................... 232 
Table 1: Values of the Normal distribution .......................................................................... 232 
Table 2: Values of the t-distribution (two-tailed) .................................................................. 233 
Table 3: Logit transformation .............................................................................................. 235 

APPENDIX E. ANSI CHARACTER SET .................................................................................. 236 

LITERATURE ........................................................................................................................... 237 

INDEX ...................................................................................................................................... 240 
 

 



 

www.medcalc.org  MedCalc manual - 1 

INTRODUCTION 

Program installation 

System requirements 

To run MedCalc, you need a PC with 2000, XP, Windows Vista or Windows 7 (32-bit or 64-bit versions), 
with at least 512 MB RAM and about 20 Megabyte free space on the hard disk. 

MedCalc installation 

¶ If you have downloaded the software from the Internet, you should locate the setup file 
medcalcsetup.exe on your hard disk and execute (double-click) it. 

¶ If you have a program CD, locate the setup file medcalcsetup.exe on the CD and execute it. 

¶ When installation is complete, you start MedCalc by clicking the Start button and point to Programs, 
next click MedCalc.  

Note: To install MedCalc you must be logged on to your computer with administrator privileges. 

Sample data 

At first run, MedCalc creates a folder named "MedCalc" with a subfolder "Sample files" in the "(My) 
Documents" map. The "Sample files" folder contains the following MedCalc sample files: 

Bland and Altman plot.mc1 
Bland Altman multiple observations.mc1 
Clustered graphs.mc1 
Control chart.mc1 
Cox regression - Gallstones.mc1 
Data for ROC curve analysis.mc1 
Dates.mc1 
Logistic regression.mc1 
Meta-analysis Continuous data.mc1 
Meta-analysis Odds ratio.mc1 
Patients - sample data.mc1 
Serial measurements.mc1 
Survival curves.mc1 
Youden.mc1 

Registration 

When you start MedCalc for the first time a dialog box appears with the following options:  

Buy now: to connect to the MedCalc web site and order a product key. 

Enter product key: to enter your user name and product key. You only have to enter your user name and 

product key once. The next time you start MedCalc, the program will not ask you this information again. 
If you do not have a product key, you can purchase one from the MedCalc web site 
(http://www.medcalc.org/). If you are a registered user and you have lost your product key, use the 
Recover product key form http://www.medcalc.org/productkey/. Alternatively, you can contact MedCalc 
Software (mailto:info@medcalcsoftware.com), and we will email you your user name and product key. 

Free trial: You can run the software, without any feature limitations, during 15 days without registration.  

http://www.medcalc.org/
http://www.medcalc.org/productkey/
mailto:info@medcalc.be
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Auto-update 

Important: the auto-update feature is only available if you have a legal, non-network MedCalc license. 

Step 1 

When you start MedCalc, the program will check whether a new version of the software is available from 
the MedCalc website. 

 

When the program can successfully connect to the MedCalc website, and an update is available, the 
following dialog box is displayed:  

 

MedCalc updates are free of charge and updating to the latest version is always recommended. 

If you don't want to install the update, click Cancel and MedCalc will remind you of the update after a user-
defined number of days (see Options, p. 60). If you do not want MedCalc to automatically check for 
updates in the future, select the option Do not check for MedCalc updates in the future. You can always re-
enable this option in MedCalc's Options dialog box (p. 60).  

Step 2 

If you click Update, the update will be downloaded from the MedCalc website:  

 

You can interrupt and cancel the download by clicking the Cancel button.  

Step 3 

When the update could successfully be downloaded, the update software is launched automatically.  

Privacy  

When MedCalc checks for updates, no personal information (name, product key) is being sent to the 
MedCalc web server. The software will only retrieve the most recent version number from the website and 
compare it with the version number of your MedCalc copy.  
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Whatôs new 

If you are already familiar with MedCalc, you can read about the latest changes and additions in MedCalc 
by selecting Whatôs new in the MedCalc Help menu. 

It is possible that new features are available in the software, which are not described in this manual. You 
can find information on these new features in the MedCalc Help file (see On line help, p. 4), or on the 
MedCalc web site (see MedCalc on the Web, p. 217). Updated versions of the manual in PDF format can 

be downloaded from the MedCalc web site http://www.medcalc.org. 

Regional settings support 

MedCalc supports regional differences as entered in the Regional settings dialog box in the Control panel. 

The following are taken from the Windows settings: 

¶ Decimal symbol: the character used to separate the decimal digits from whole numbers.  

¶ List separator: the symbol used to separate elements in a list, e.g. arguments in spreadsheet 

functions, or fields when exporting data as a text file. 

E.g. when the list separator is a comma, the arguments in the RANDNORM function are separated 
by a comma: RANDNORM(m,s). If the list separator is a semicolon, the arguments are separated 
by a semicolon: RANDNORM(m;s). 

The list separator is also used to separate the fields or variables when you export spreadsheet 
data. 

The list separator cannot be equal to the decimal separator! 

If MedCalc finds the list separator to be equal to the decimal separator in the Windows settings, 
then it will use a semicolon as the list separator when the decimal separator is a comma. 

¶ Date format: MM.DD.YY, DD.MM.YY or YY.MM.DD (see Date functions, p. 225). 

You can use different characters for the Decimal symbol and List separator in the Options panel, see 
Options, Regional settings, p. 60. 

The MedCalc menu bar 

After starting the program, the MedCalc program window appears, with a menu bar at the top of the screen 
containing the following headings: 

¶ File Disk input and output of spreadsheet data files, printing, quit MedCalc 

¶ Edit  Cut, copy, paste, find, insert, ... 

¶ View  Open Contents bar, spreadsheet, notes editor, set view characteristics... 

¶ Format Character formatting, spreadsheet & column format, graph formatting, é 

¶ Tools Sort data, edit variables list, options, é 

¶ Statistics Statistical analysis of spreadsheet data, t-tests, Wilcoxon tests, comparison of groups, 
method comparison, ROC curve analysis, etc. 

¶ Graphs Statistical graphs, Kaplan-Meier survival curve, Control chart  

¶ Tests Statistical tests on tabulated or summarized data (useful when you do not have the raw 
data available in the spreadsheet): difference between means, standard deviations, percentages, 
correlation coefficients, relative risk, odds ratio 

¶ Sampling Calculation of sample sizes 

¶ Window Rearrange windows or activate a specific window 

¶ Help Get help and information. 
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On line help 

At any moment during working with MedCalc on line help is available, e.g. information on a menu item, 
explanations on a dialog box, etc. After you press function key F1 the program displays a context-sensitive 
help text.  

You can also call the help function by selecting Contents and Index in the Help menu. 

Help in dialog boxes 

To get comprehensive help on the dialog box, click the Help button.  

To get help on any item in the dialog box: click the question mark  in the title bar of the dialog box, and 
then click an item in the dialog box.  

¶ You can print or copy the information in a pop-up window by right clicking inside the pop-up 
window, and then clicking Print Topic or Copy.  

¶ To close the pop-up window, click inside it.  

¶ You can also get help on an item by right-clicking it, and then clicking What's This? 

ScreenTips & quick help 

When the mouse is moved over one of the buttons in a toolbar, a short explanation appears in a small 
popup window. 

While you are making a selection in the menu, a description of the highlighted command is displayed in the 
status bar at the bottom of the window. 

The spreadsheet data window 

In MedCalc, data are entered in a spreadsheet. You open the spreadsheet window by selecting 
Spreadsheet in the View menu, or selecting Data in the Contents bar. 

 

One cell (rectangle) of the spreadsheet is highlighted. This rectangle is called the cell pointer. 

The first character(s) of this cell address (A) is the column indicator and the next number is the row 
number (row 1 is the first row number). Above row 1, there is an additional fixed row where you can enter 
a column heading, i.e. a name for the variable for which data will be entered in this column. 

The column and row of the cell pointer are also called the current column and row. 

The cell pointer can be moved with the arrow and/or cursor keys, or by means of the mouse. When you 
click on a cell, the cell pointer jumps to this cell. You can browse in the spreadsheet window by clicking on 
the right and bottom border of the spreadsheet window, or by using the Page Up and Page Down and 

other cursor or arrow keys. 

By pressing the Ctrl+Home key you move the cell pointer to the first data cell in the spreadsheet: cell A1, 
and with Ctrl+End to the last cell used in the spreadsheet. 

You can fix a number of columns in the spreadsheet by using the Split window command (see p. 215): 
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Total number of columns and rows in the spreadsheet 

The default number of rows in the MedCalc spreadsheet is 100000, and the number of columns is 16384. 
However, you can configure MedCalc to contain a lower number of rows. The number of rows available in 
the spreadsheet can be set in the Options dialog box, described on page 60. 

How to enter data 

Data for the different variables are entered in different columns of the spreadsheet. All data for a single 
subject or case are entered in one row in the spreadsheet. In the top row of the columns you can enter the 
names of the variables.  

A variable name should not include any spaces. If necessary, you can use the underscore character _ to 

separate words, e.g. GRADE_A. Also the following characters cannot be used in a variableôs name:  

  - + / * = < > ^ ( ) $ ñ ó : , .  

In addition, the variable name must not start with a number and must be different from reserved words 
such as TRUE, FALSE, ROW and COLUMN. 

The variable name should also not be equal to the address of a spreadsheet 
cell such as A1, S1, AB35, IL6, etc. 

In order to enter the variable name LENGTH in the top row of column A, you first position the mouse 
pointer on this cell, and click the left mouse button. The cell pointer is now located in this cell, and you can 
type the variableôs name on the keyboard. Next, you press the Ć key to actually store the name in the 
computerôs memory and move the cell pointer to cell A1. You can now enter the first value 171 for the 
variable LENGTH in this cell, followed by pressing the Ć key to go to the next cell. 

The data are not stored in the computerôs memory until you have pressed the 
Enter key, or have moved the cell pointer to another cell. 

When you want to change or edit the content of a cell, place the cell pointer on this cell and press function 
key F2. You can now move the cursor in the cellôs text by means of the arrow keys ă and Ą and make the 
necessary changes. After you have made the changes, press the Enter key or move the cell pointer to 

another cell to store the new cell content in memory. 

While you are entering data you must, from time to time, save your data on the disk. When you save the 
file for the first time then select the command Save as in the File menu, and next enter the file name in the 
file selector box described on page 10. After you have given a name to your data file, you can select the 
Save command in the File menu to save your data under the same file name. 

If you do not save your data on the disk, your work will be lost when: 

¶ you exit the program 

¶ switch of the computer 

¶ there is a power failure or a system or hardware malfunction. 

The program automatically formats the numbers that you enter according to the number of decimals 
selected in the Format spreadsheet box (see p. 42). 
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If you want a different number of decimals for a particular column, then select Column in the Format menu 

and enter the new number of decimals. In this dialog box you can also specify a different width for the 
column. You can also specify that a format for the data in the column. 

For example when column A contains dates, select the ñDateò format: 

 

 

A variable may either be categorical or numerical. Categorical variables may either consist of numeric or 
alphanumeric (string) data. A numerical variable always consists of numerical data. 

Categorical or qualitative variable 

Categorical or qualitative data may either be entered as numbers or as text strings. A text string consists of 
one or more alphanumeric characters, placed in quotation marks. The program will consider every 
expression that cannot be interpreted as a number to be a string, even if it is not placed between quotation 
marks, e.g. ñGreenò, yellow, ñ10ò. Distinction can be made between Nominal and Ordinal data: 

Nominal data : a classification without obvious order, e.g. blood group, male/female. 

Ordinal data : ordered categorical data, e.g. endometriosis stage, varicocele grade. 

A variable that can only have 2 values is also called a dichotomous variable, for example pregnant/not 
pregnant, male/female. 

In MedCalc, it is often useful to code categorical data with numerical values: 0 and 1, or 1 2 3 4, etc. 

Numerical or quantitative variable 

A numerical variable consists of numbers, for example 0, 25 or 3.258, or expressions that can be 
interpreted as a number, e.g. LOG(25) or SQRT(VAR1) where VAR1 is a variableôs name containing 
numerical data.  
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Numerical data may either be continuous or discrete. 

Continuous data : numbers that can theoretically assume any value between two given values; usually 
measurements, for example: the height of a person. 

Discrete data : data that are not continuous (and may have a limited number of values), usually 
counts, for example: the number of children in a family. 

You can easily convert a numerical variable into a categorical variable using the Create groups tools (see 
p. 50-52) or the CATEGORISE function (see p. 226) or IF function (see p. 227). 

How to enter dates 

First open the spreadsheet (select the Spreadsheet command in the View menu or click the  button) 
and enter a heading in the column that will contain the dates:  

 

Next, select the Format spreadsheet command in the Format menu or click the  button. 

 

On the Column tab, select the "Date" option for "Format" and increase the column width to e.g. 12 so there 
is enough space to enter dates. If you do not specify "Date" for "Format", MedCalc will display the number 
0.0127551 when you enter a date as 5/7/56 (5 divided by 7 divided by 56). 

Now you can start entering the dates. MedCalc allows entering dates using a slash or dot or any non-
numerical character as a separator: e.g. 10.12.88.  
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How MedCalc handles date and time data 

MedCalc stores a date and time as a number ddddd.tttttt with the integer portion ddddd representing the 
number of days since 1801-Jan-1, plus a fractional portion of a 24 hour day tttttt. The number ddddd.tttttt is 
called a serial date, or serial date-time number. 

The date format, i.e. the way the serial date number is converted to a string, can be chosen in the 
Regional settings dialog box of the Control box window that is part of the Windows operating system (see 
your Windows documentation).  

Serial date numbers can be used for comparison, sorting, arithmetic operations and statistical analysis. 

For example: 

 

Both columns A and B have been formatted as Date, see above. 

When you enter a date in the spreadsheet with a year less than 100, MedCalc will interpret this year as a 
year in the 20th century: 20.12.88 = 20.12.1988. When you enter 0 as the year number, MedCalc will 
interpret this as the year 1900: 20.12.00 = 20.12.1900. So when you want to enter a date situated in the 
19th or 21st century, enter the year using 4 digits.  

Dates 

The integer portion of the serial date-time number, ddddd, represents the number of days since 1801-Jan-
1, with 1801-Jan-1 begin the first day. For example, the date 5-Jul-2011 is stored as 76887. 

¶ Date strings, for example "5.12.72" or "5.7.1956" can be converted to serial date numbers using the 
DATEVALUE function (see Date and time functions, p. 225). 

¶ A serial date number can be back-transformed to a date string using the DATE function.  

Times 

The fractional portion of the serial date-time number, tttttt, represents the fractional portion of a 24 hour 
day. For example, 6:00 AM is stored as 0.25, or 25% of a 24 hour day. Similarly, 6PM is stored at 0.75, or 
75% percent of a 24 hour day. 

¶ Time strings, for example "14:30" can be converted to serial time numbers using the TIMEVALUE 
function.  

¶ A serial time number can be back-transformed to a time string using the TIME function. 
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Missing values 

The data for all variables of one case (patient, sample) are entered on one row in the spreadsheet. When 
for one variable you do not know the value (or entry) for the case, you leave the corresponding cell blank 
and do not enter any data in this cell. 

As a rule, the program will ignore an entry for a numeric variable when it is unable to interpret this entry as 
a number. 

When text is entered in a cell for a numeric variable, the program will not take this case into account for 
calculations (it will not substitute the text value by a zero).  

The following are recognized as numbers: 

5.4 
LOG(36.5) 
HEIGHT/WEIGHT (when óHeightô and óWeightô are correctly defined variables) 
HEIGHT/100 

The following are not recognized as numbers and are ignored for calculations: 

5,8 
ó4.6  
LOG(CONC) (when óCONCô is not a correctly defined variable or in case the variable 

óCONCô has a zero, negative or missing value) 
SQRT(-9) (error!) 
1/ HEIGHT (when óHEIGHTô is not a correctly defined variable or in case óHEIGHT 

equals zero) 

Data checking 

After having entered the data, you should carefully check the data to ensure that they have been entered 
correctly. 

Sometimes erroneous data input will become apparent when looking at the data range in the summary 
statistics report (e.g. maximum value of 78 for pH), or when plotting box-and-whisker plots, dot plots or 
scatter diagrams for the different variables. You should check clear outliers since they may indicate 
incorrect data entry, or they may result from a technical failure in measurement or from a study protocol 
violation. Only for such plausible reason you may exclude a value from further analysis, and not simply 
because a value is the smallest or largest. If there is no evidence of such a mistake then the value must 
remain unaltered. 

You can locate any value in the spreadsheet using the Find procedure (p. 35).  

You can exclude outliers from further calculations by using the Exclude command (p. 45).  
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How to save data 

When you want to save the data, select the command Save as in the File menu. The program will display 

the following dialog box: 

 

¶ Save in: select the directory where you want to save the data file. 

¶ File Name: select or type the name of the file for the data. This box lists files with the file name 
extension selected in the Save as type box. You can select a file by clicking on a file name. 

¶ Save as type: select the type of file you want to see in the file name list box.  

When the correct file name is entered, click the SAVE button.  

Statistics 

After you have entered data in the spreadsheet, it is advised to save the data on disk. This is done by 
selecting the command Save as in the File menu. You will have to enter a name for your data file in the 
File selector box (see p. 10). 

To load a data file from disk, select the command Open in the File menu. Next, select the name of the file 
in the File selector box. For example, you can select the data file Patients - sample data.mc1. This file 
contains data on length and weight for a number of persons. 

When you want to obtain summary statistics for the variable Weight, select the command Summary 
statistics in the Statistics menu. The following dialog box appears on the screen. 
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Click the  button to obtain a list of variables. 

 

From this list you can select a variable by clicking on the variableôs name. 

 

If the variable requires a logarithmic or square root, or any other mathematical transformation, then you 
can enter a formula in the variable field: 

 SQRT(WEIGHT) 
 LOG(LENGTH) 

or you can enter a formula combining different variables, e.g. 

 WEIGHT/LENGTH  

By doing so, new variables will be added to the variables list: SQRT(WEIGHT), WEIGHT/LENGTH, etc.. 

For an overview of mathematical operators and functions available in MedCalc, refer to pages 219 and 
220.  

Optionally, you may also enter a selection criterion in the Select field of the dialog box, in order to include 
only a selected subgroup of cases in the statistical analysis. 
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The Select field may contain a combination of different criteria, using the AND and OR functions (see also 

p. 226):  

 AND(LENGTH>160,LENGTH<170) 

These expressions may make use of all mathematical and other spreadsheet functions as described in a 
next part of this manual (p. 219). 

After you have entered a selection criterion in a dialog box (in order to include only a selected subgroup of 
cases in the statistical analysis), this selection criterion will be órememberedô by the program and will be 
selectable in the Select list. 

After you have clicked the OK button, the following statistics are calculated and displayed in the results 

window: 

 

For more details about the displayed statistics, see p. 62. 

Note that when you change the data in the spreadsheet, this will not automatically cause a recalculation of 
the displayed statistics, but you have to repeat the statistical analysis for the new data.  

To facilitate this, use the Named tests and graphs feature: by clicking the  button you can save the 
analysis so you can recall the analysis later, possibly with new data. After you have clicked this button the 
graph is added to the Named tests and graphs list in the Contents bar, with a default name, which you can 
edit in the Contents bar (see p. 40). 

Graphs 

When you want to create a graph, proceed in a way similar as for any other statistical procedure. As an 
example, you will create a histogram for the variable Weight of the data file you have loaded in the 
previous section. 

To obtain the histogram, you select the command Histogram in the Statistics menu.  
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A dialog box is displayed similar to the one for Summary statistics. Again, enter the name of a variable and 

optionally a selection criterion. If you have previously entered this selection criterion in e.g. the dialog box 

for summary statistics, then this it be selectable in the Select list (click the  button). 

 

When you have identified the variable in the dialog box, click the OK button to proceed. The program will 
display the following box: 

 

After you have clicked OK the histogram will be displayed in a new window: 
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To get statistical information on the data represented in the graph (sample size, etc.): 

¶ click the right mouse button in the graph window: 

 

¶ select the Info command in the shortcut menu. 

By clicking the  button you can save the graph so you can recreate the graph later, possibly with new 
data. After you have clicked this button the graph is added to the Named tests and graphs list in the 
Contents bar, with a default name, which you can edit in the Contents bar (see p. 40).  

Graph formatting 

Click the  button in the Formatting toolbar to format the graph. The effects of the changes in the left 
panels (displayed below) of the dialog box can be previewed in the right panel: 
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Scheme 

In the graph colors box you can select a color for every object used in the graph.  

 

Schemes 

In this box you can select a predefined or user-defined color scheme. 

Á Save scheme: "Save scheme..." can be used to save the currently defined color selections as a 

named scheme for later use. 

Á Set as default: When you click "Set as default", the current color scheme will be saved and used as 
the default color scheme for new graphs. The color schemes also include the Fills, Lines and 
Marker style and color selections. 

Á Delete scheme: Click this button to delete the currently selected color scheme. 

Á Restore predefined schemes: Click this button to restore the different predefined color schemes. 

Options  

¶ Display grid: displays gridlines in the graph.  

¶ Plot area border: XY only: when this option is selected, lines for the X and Y axes are drawn. If this 
option is not selected, the plot area is enclosed in a rectangle. 

¶ Outside tickmarks: select this option to have the tickmarks drawn on the outside of the graph frame. 

Titles 

In this box you can edit the main text sections (title and axes) of the graph. 
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Axis 

In this box you define the scaling of the X and/or Y-axis by entering the following information: 

¶ Minimum: this is the lowest value that appears on the utmost left of the X-axis or bottom of the Y-
axis; 

¶ Maximum: this is the highest value that appears on the utmost right of the X-axis or top of the Y-

axis; 

¶ Increment: the increment value between two major grid lines; 

¶ Minor tickmarks: the number of minor tickmarks between two major increments. 

 

In MedCalc, the default increments are 1, 2 or 5 times a power of ten, yielding about 6 to 10 major 
tickmarks. If you are preparing a graph for publication, you are advised (Tukey, 1977) to limit the number 
of major tickmarks to about 2 or 3, so you will have to increase the value for increment, preferably also 
steps of 1, 2 or 5 times a power of 10. 

If a logarithmic transformation of the data was selected in the graphôs dialog box, then the information for 
the lowest value (Minimum) and Increment must be logarithmic values as well (e.g. for Minimum enter -2 
for the value 0.01, or 0 for the value 1, 3 for the value 1000, etc.). Increment is then the exponent 
increment and should preferentially remain equal to 1. 

After clicking OK, the graph will be replotted using the new axis scaling. However, the program will ignore 
a new axis scaling if this new scaling would cause data to fall outside the full axis range. 

Font 

In this box you can select the font, font style and font size used in the graph. The font Sample box (in 
which you can enter text freely) ignores the selected font size. The effect of font size can be seen in the 
Preview box. 
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Format graph components 

To format different graph components, right-click on the component and select "Format..." in the popup 
menu. 

Example 

In a box-and-whisker plot, right-click on a marker. 

 

Select "Format marker..." 

Select the desired marker attributes in the dialog box. 

 

Add graphical objects 

In all MedCalc graphs, you can add additional text boxes, lines, rectangles, ellipses and connectors. 

Text box 

Example:  

 

To add a text box in the graph: right-click in the graph and in the popup menu select "Add" and "Text box": 






































































































































































































































































































































































































































